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BEST PRACTICES COURSE – WEEK 21 – Creating and Customizing 
Library Parts PART 4 - Creating New Objects with Custom 3D 
Hotspots and 2D Symbol 
 

Hello, this is Eric Bobrow.  In this ArchiCAD video tutorial, I'm going to teach you how to create your own 

custom 3D object simply by modeling the elements while being able to also customize the 2D and 3D 

hotspots that allow you to snap to the object and customize the 2D symbol as well. [0:00:25] 

This all started out a few days ago when Francois Swanepoel, one of my colleagues working with 

ArchiCAD in South Africa, sent me an e-mail and said that he needed some help with a particular GDL 

question.  He pointed out this particular ArchiCAD Talk post which he asked how to add hotspots to an 

object easily.  Now I responded to his question and gave him some information about how you can place 

hotspots onto the floor plan and save it along with the object to customize it. [0:00:58]  

Roberto Corona, a very well known ArchiCAD expert, ArchiRadar, added some more information. And 

then Francois actually posted a question.  He had done some of the stuff that I had suggested and ended 

up with some improved results in terms of some additional hotspots.  However, he pointed out that the 

original elements that he had modeled had hotspots in all of the key places, but the new element in 3D 

did not have it.  So then the question became, "How do you create 3D hotspots?" [0:01:32] 

Roberto Corona created a whole scripted solution here, he's very clever with the GDL, and went on with 

another addition there. And Francois said he would try to figure this out.  Well as I looked at it, I realized 

that there was a way to do this graphically, and I replied back to Francois the next day saying I've come 

up with a straightforward way to do this and I'm going to create a video.  In between now and then, 

Roberto created something very similar to what I suggested.  He made a 3D hotspot object and used it 

to add the grip points. I thought, well I still want to make this video. So I'm going to do that for you right 

now.  [0:02:16] 

So let's take a look at the situation here. This is the file that Francois sent to me with a few additions.  If I 

go to 3D, we will see his initial elements were made out of slabs, columns, and beams.  Now he saved it 

as a library part and it ended up with just hotspots on the corners and the center.  That's the bounding 

box hotspots.  So nothing at the points that you might want to snap to on these corners here. Following 

the trick that I gave him, he added some additional hotspots on the floor plan.  I will show you how that 

is done.  [0:02:58] 

He basically took the elements and added some additional hotspots here and then instead of having just 

a simple library part like this, he ended up with one with additional hotspots that you can snap on the 

floor plan. And if we look in 3D, also in 3D; but still no hotspot at the corner here.  Now I'm going to 

show you in the next few minutes how you can create a smart part.  You can see this one has hotspots 
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on key points.  You could have as many as you like.  I've put in some of the obvious ones here. And I will 

also demonstrate some interesting tricks with the Cylinder tool to show you some additional capabilities 

of creating custom library parts.  [0:03:43] 

Let's start out by creating an object in the first simple method that has been around in ArchiCAD 

probably since near the beginning.  I'll go ahead and select these elements here and show them in 3D.  

I'll take a view of them from a very special position.  I'll go to the View menu, 3D View Options, 3D 

Projection Settings.  I'll make sure that we are in a parallel projection.  If we are in perspective, then I 

need to click on the parallel button so I get this type of a view.  I will make sure that I'm taking a top 

down view and that I have the camera for example on the 270, which would be from the bottom of the 

screen.  [0:04:32] 

That gives me a view similar to the floor plan just in 3D, and I can go and turn these elements into a 

single object at that point.  In versions of ArchiCAD up until recently, you could go to the File menu, 

Libraries and Objects, and say Save 3D Model As and proceed. But in the latest versions of ArchiCAD, 

you have to select the elements first in order to save them.  So what I'll do is go and simply select 

everything here that is in the current 3D world that went to 3D, and now I can go to File, Libraries and 

Objects, Save Selection As, Object. [0:05:13] 

ArchiCAD in recent versions gives me a little message saying it's going to use this view as the top view of 

the object.  It always did that, but now it’s actually giving a little advice message.  I'm going to give this a 

name here; we'll call this "Simple top down object".  So I am taking the view from the top going down, 

and say Save.  I had created one earlier when I was preparing this, so now I have two of them, but I 

overwrote it.  Now in ArchiCAD 16, we have some additional controls which we are not going to focus on 

in this tutorial so I will simply say OK and return to the floor plan.  Having done that, I will go to the 

Object tool and I will click to place this object.  [0:06:03] 

Now will point out that this object I just created is transparent so we can see through to the grid behind.  

And even this element here, which is one of the feet, we are seeing the line there. Earlier, this raw 

element, being a column, was opaque and was covering up that line.  So we have a top down view of the 

object, but the line work is transparent.  That's going to be different when we do it in different ways.  So 

I am going to select these elements here, and we will go and look at them in 3D, switch perhaps to an 

axo view so we can see them in relationship to each other. [0:06:49] 

And we will see that here are the original elements with all the snap points for the slabs and beams and 

columns. And here is the new element which just has hotspots on the bounding box.  You can see the 

four on the sides and the center point and also floating up at the top height of the element.  So that's 

one way that you can create an object and it works very quickly, but it has some limitations.  Now 

another way that we can do this is I can literally select these elements here in the floor plan and go File, 

Libraries and Objects, Save Selection As, Object - right here on the floor plan.  [0:07:27] 
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When I do that, and we call this "simple plan view object" here, again, I'll just skip through all of these 

things, and just say OK.  Now if I place this new version of the object here, we'll see that this one, if I 

drag it a little bit, we will see that it has carried over the opaque nature of the columns.  Now that's 

important.  What it did was it actually took the same information that was on the plan and this is exactly 

the same.  You may notice that this one also has just two lines here and this one has three. That's 

because on the plan we were seeing the center line of the beams that were done, whereas in 3D, w 

were only seeing a top down view.  [0:08:22] 

Now what I really would like to have is something like this object here, which has an opaque fill that 

covers up the elements underneath such as a fill pattern and also perhaps a slightly different symbol - in 

this case, I have made it a little simpler.  And I also want to make it have the snap points in 3D.  So let me 

just demonstrate something here.  So I'll say Show All in 3D, and we'll take a look and see that this 

object here is a simple cylinder. And this is an object from the standard library of ArchiCAD.  You'll notice 

that it has hotspots not on the bounding box but on some very special points there. That is because it 

was scripted by Graphisoft, it's a very intelligent object. [0:09:14] 

Now what I'm going to do is build up a little mini table using this object, and we will demonstrate how 

these hotspots that are in this object are actually retained when we turn it into a new object made of 

multiple pieces.  So I'm going to go and use the Drag command. I'll just hit Command+D and drag and 

this element up on top of itself. Before I finish it, I will press and release the Option key, or it would be 

the Alt key on Windows, and that will create a copy.  So I've now dragged a copy up there.  The reason 

why I want to do that is I want to model something.  [0:09:52] 

I'll edit the hotspot here and take this down to a smaller dimension. Then go to the center hotspot and 

use the same pet palette editing to make a center post. Let's say that it's this height here.  And then I'll 

take this bottom one, drag a copy again.  This time I will snap it to going up on the Z and snap it to the 

top here. So now I've got a little table we could call in it.  Now I'm going to go ahead and simply select 

these elements here on the floor plan.  This has now selected these three elements, and I will go ahead 

and save them as a new object.  And we'll call this "small round table".  [0:10:46] 

And what I will point out is that when I go to the Object tool and place this small round table here, it has 

hotspots on the bounding box, but it also has hotspots where the original elements were placed.  And if I 

go to 3D here, you'll see that it has hotspots on those same points.  So the hotspots that were on this 

element have been carried over to the corresponding part of the new object. [0:11:19] 

Now the point that I want to make is that if you were creating your custom object out of parts like slabs, 

then those hotspots do not come across normally when you save it as an object. But if you create pieces 

of objects and they have hotspots, they do come across.  Now, I want to clean this up so that we don't 

have the extra hotspots in the corners, that really is something that is not very helpful in this case, 
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because this is a round object and the corners really don't relate very precisely to placement of the 

element. [0:11:56] 

Now with the element selected in either 3D or 2D, I'm going to go to the File menu, Libraries and 

Objects, and I will say Open Object.  We can also use the keyboard shortcut.  And we can do this in 2D or 

3D by selecting a single object. Then we can see its definition.  Now these table here, in ArchiCAD 16 this 

looks a little different. In earlier versions of ArchiCAD we might open up directly to the parameters 

which would show a bunch of different options for sizing or things like that. [0:12:29] 

Now in earlier versions there would be a button at the top that would say Details.  We can click here to 

get it ArchiCAD 16.  In earlier versions, we might see the command that I am going to point out next 

directly in the Details area.  Here we have to click on Compatibility Options.  And now I can point out the 

command I'd like to change which is I would like to turn off the hotspots on the bounding box.  So when 

I turn that off and say OK and then hit Save, Command+S or Ctrl+S, now I go back to the floor plan. You 

will see that this object no longer has the extra hotspots in 2D, and in fact when I go back to 3D, you can 

see those hotspots have also disappeared. [0:13:13] 

So I was able to change that for this custom object by selecting the object, going to the File, Libraries 

and Objects, Open Object. And then in the Details area - in ArchiCAD 16 it's under Compatibility Options 

- I turned off hotspots on bounding box.  In earlier versions of ArchiCAD it might be under Parameters 

and then a Detail button. It would have a similar option there.  So now I'm ready to actually show you 

how to create a smart version of this chair, one that has these hotspots.  I will point out that there's this 

little element sitting right here that you may not have noticed.  It's a custom object that I created, very 

similar to what Roberto Corona created, and it's called "Hotspot Placement Tool".  [0:13:58] 

Basically it's just a little script that just draws three lines in space and has a snappable point in the 

middle of it.  It can be sized to any size. This is described in 150 mm, so that would be about 6 inches for 

American standards.  And this basically is going to snap.  That's all it does, it's just a snap point.  So what 

I'm going to do is actually drag a copy of this.  So I'll just drag a copy of this over near the other element 

here and then I'll go back to the floor plan. And you will see that the element now is right in the same 

vicinity. [0:14:42] 

So let's take a look at how we can add hotspots in 2D and hotspots in 3D to this object and make it really 

smart.  So I will go to the More section and go to Hotspots here. And I'm going to put in hotspots just 

like you saw below here.  I will put in hotspots at the corners because those are of interest, but I will also 

put them in say at the corners of the support legs. And I will put them in perhaps at the center points.  

These are arbitrary; it could be anything you like.  But wherever you put these hotspots you are going to 

have snap points. [0:15:26] 
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I'll go and select all of these elements here. And let me just deselect this 3D hotspot here so it's just not 

included.  So now I have these selected.  I'm going to go to the File menu, Libraries and Objects, Save 

Selection As, Object, and we will call this "Chair with 2D Hotspots" and save that.  Having done that, if I 

go to the Object tool and place it, we will see that it has this new object with these additional spots.  It 

also has this center hotspot and actually duplicate ones at the corners because in the object definition, 

which I can get to by opening the object settings, we have hotspots in the bounding box which I've just 

turned off. And I will say save. [0:16:23] 

And now when I go back to the floor plan, you can see that has gone away.  Now if I go to 3D with this, if 

I say just show me the selected element in 3D and I select it, you'll see that it's got these additional 

hotspots on the floor plan.  We are at the same level as the floor plan, plus they are floating above.  And 

that's what Francois had reached. And he said, "How can I get hotspots on these corners here?"  So I'm 

going to show you how that works.  [0:16:52] 

You see this little 3D hotspot here? I will go in and take a look at these elements only. You can see that 

I've got this hotspot sitting here that I can move around. Now I'm going to move it right on top of that 

corner.  Now I'll go in and use the command that says I'd like to create multiple copies of this.  And I will 

go and take it from here on top of this corner, top of this corner, and rotate around. And let's see if we 

can rotate around here.  Looks like I got an extra one that I didn't need; I'll delete that afterward.  So I'll 

just take all of these and one more. Now hit the Esc key, and I've now got these snap points on all of 

those areas. I have this one extra one that I'm going to get rid of. [0:18:10] 

Now if I were to save this as an object at this point, we would have snap point at each of these corners.  

But we would also have these extra funny little lines, which is not what I want.  So we'll just select all of 

these objects here.  Actually, let me just do it on the floor plan where it may be a little bit more 

interesting of a teaching lesson.  I will go to the Marquee tool and say I'm interested in this area here. 

And then go to the Edit menu, Find and Select, and say that I would like to find and select things inside 

this marquee. And I want to use the name that is the "Hotspot Placement Tool".  [0:18:53] 

If I didn't have that set up, I could go and eyedrop this, and that would actually say that I'm looking for 

the hotspot placement tool.  If I eyedrop something else like this element, then it's saying that it's 

looking for cylinder 16.  But really what I want is the hotspot placement tool, and I want it, instead of 

outside the marquee, I want to look for them inside the marquee.  And then I hit the "+".  You can see 

it's found ten of them, so there were then that were in this area, and now I can go into the settings for it 

and actually just change this from having a dimension here - I will just lock them so they are all the 

same. And make this zero, and you'll see it's sort of disappeared from the screen.  [0:19:41] 

It will still be there as a hotspot but there won't be any lines.  Now you can see that the 2D symbol just 

changed, or the 2D information just changed.  Now I'm going to go and close up the find and select here 

and just with the Arrow tool select everything in the marquee.  So selecting everything in the marquee 



 
 

  Best Practices Course – Week 21 Part 4 – © copyright 2012 by Eric Bobrow 
 
 

selected all of the model plus all of the hotspots, both 2D and 3D.  I don't want the fill element as part of 

it.  So now I have all of that selected and I'm going to go and say save this selection as an object.  I will 

call it "Smart object with extra hotspots".  [0:20:28] 

Having done that, if I go ahead with the object tool and place this, let's just sort of pop it in, you can see 

that it has the extra hotspots on the plan but it still has a center hotspot. And if I go to the 3D on it, we'll 

see that it has the extra hotspots, the smart ones, in 3D but it still has the extra hotspot in the center 

that I don't want.  So with this selected I will go and clean that up with File, Libraries and Objects, Open 

Object, and then go into the details to turn off the hotspots on the bounding box and save. Then go back 

to 3D view, and you can see it's updated, it took that away.  [0:21:15] 

If I go back to the floor plan it also took that away.  Now the one other thing I want to do here is I want 

to make this object - and I will just drag it over so we can see it - connection with this I want to make it 

have an opaque fill so that it covers things up on the floor plan.  I also want to modify or perhaps 

simplify the symbol.  So this is just a good example for how we can do that.  So I'll use the shortcut to 

open up the object that we've just been looking at. I will point out that the object 2D view looks like this. 

[0:21:53]   

So this is what ArchiCAD is drawing on the floor plan.  Now we can't really edit this information because 

this is being created by a 2D script which has a whole lot of text information. As an expert, I could go in 

and do things with it, but it's rather cumbersome, and is actually much easier to work with a 2D symbol 

for the object. However, the 2D symbol, which we can draft with, you can see that we have actually 

access right now. And this is up to 2D drafting tools, this actually is has nothing in it. [0:22:28] 

So in order to get something in it and actually work with that, I'm going to go back to the 2D view and 

select all here and copy. Then go to the 2D symbol and paste. And I will tell it to leave it in the original 

location, that's important, because it will actually line up properly; and I'll say zoom to paste in 

elements. So you can see how it brought in that information. I click outside the marquee to complete 

the paste. At this point, this information can be edited freely, it's just line work.  [0:23:08] 

So I will go in and select this stuff and delete it. Then go in here and delete this line work and this line 

work here. Then draw a line and eyedrop this and draw a line across, and I've now got a simpler symbol.  

Let me just save this and we'll see when I go back to the floor plan how this symbol - actually the symbol 

has not updated because I forgot one important thing. It's actually got the information that I drew but it 

also has the old information.  So if I go back to the object here you'll see that the 2D symbol has this 

information, but we still have a script in the 2D area here. [0:24:18] 

To fix that all we have to do is - after the first few lines that define this, I can just go in and put in a few 

blank lines and type the following text:  
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fragment2 all, 0 

end 

And what that does is it says put in the symbol on the floor plan just what is seen in the 2D symbol area 

and then end.  Don't do any of this other scripting.  So now when I say save and I go back to the floor 

plan, you can see how the symbol has updated. It's just got the single line as opposed to the other.  Let 

me just move this a little bit over so it isn't too confusing here.  [0:25:05] 

Now I wanted to have an opaque background just like this one.  How do you think I can do that?  Well 

let's just open this up again here and go to the 2D symbol and go to the Fill tool.  Make sure the Fill tool 

is set to whatever you want. In this case I'll make it airspace, so it has no line work, and I'll make the 

background of it be opaque. And I can go and simply draw a box. And although we don't see anything, it 

is a fill that I can select, and of course it will be part of the symbol.  When I hit save and go back to the 

floor plan, you can see now this symbol is opaque unlike the other ones.  So it will cover things up 

underneath it. [0:25:49]  

So we now have a smart object that has 2D hotspots in just the places we want as well as 3D hotspots in 

just the places we want here.  And it has a custom symbol that has been simplified or modified as we 

wanted and even had an extra fill put in. I have one more quick demonstration here. Let me move this 

object off to the side. Remember when I saved the object the very first time with a top down view and 

ArchiCAD said that's going to be the plan view. Well let's take a look at one variation that has been 

around for generations of ArchiCAD and that is if I take these elements and look in 3D here, you can 

seen what I called the table earlier, which these are the raw pieces that I've got. [0:26:44] 

Now I'm going to change my view.  Let me go to the View, 3D View Options, 3D Protection Settings. And 

instead of looking in just sort of an arbitrary view, I'm going to switch to instead of a top you a side view.  

And while it could be from different angles, a common one is to put it right at the top of the screen at 

90° for the azimuth. When I say OK, you can see that we're looking at an elevation from the side, in this 

case sort of from the top of the screen.  And that is what is going to become the top of my new object.  

So I select everything - because in ArchiCAD 16 you need to have it selected before you can do this - go 

to the File menu, Libraries and Objects, and Save 3D Model As or Save Selection As, Object. [0:27:35] 

It's telling me what I'm telling you, which is that this current view will become the floor plan view of your 

new object.  It will rotate it so that this makes sense, so that will be the actual view.  And now I will call 

this let's say "Hollow wheel object".  So I am basically creating something arbitrary here. But when I go 

back to the floor plan, if I go to the Object tool and place it, you can see how it's placed precisely in that 

orientation.  Now if I just show everything in 3D and we go to the axo view so we can see everything 

perhaps down below here, you can see how this new object has worked in terms of having the top view; 

what was the side view became the top. [0:28:38]   
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So now in this video tutorial we've gone over how you can take raw pieces like this, along with hotspots, 

those extra little snappable points - which I'm going to make available publicly so that you can use it or 

you can use Roberto Corona's version.  And you combine them into a composite group of elements and 

save it along with the 2D elements so that you end up with a smart object here that has hotspots where 

you want it in 3D as well as having just the hotspots that you want in 2D. [0:29:23] 

And then as a final little explanation, I showed how you can take objects that are in one orientation, 

perhaps a combination of elements that you model in one orientation because it's easier to control or 

easier to work with and then save them in another orientation by working in that elevation to save the 

new version of the part.  [0:29:48] 

So this concludes my tutorial on how to create custom 3D objects by modeling them, adding in hotspots 

in 2D and 3D to have custom snap points, and how to actually edit and customize the 2D symbol as you 

wish.  This has been Eric Bobrow; I look forward to reading your comments and your questions. Please 

post them on the page down below.  Thanks for watching. 

[END OF AUDIO 0:30:17] 


